I. Choose the correct answer:

1. Which one of the following is a partner in every sphere of human life and activity?
   (a) Government  (b) Education  (c) Computer  (d) Music

2. What are the basic operations performed using computer?
   (a) Addition  (b) Subtraction
   (c) Multiplication and Division  (d) All of these

3. The word computing means ……………
   (a) instruction  (b) information  (c) accuracy  (d) act of calculation

4. Which is the first known calculating machine used for counting?
   (a) Slide Rule  (b) Abacus  (c) Napier Bone  (d) Engine

5. Who invented Napier’s Bones?
   (a) John Napier  (b) William Oughtred
   (c) Charles Babbage  (d) Napier Bone

6. What digit named as a constant rod in Napiers Bones?
   (a) 1  (b) 9  (c) 0  (d) 4

7. Who invented slide rule?
   (a) John Napier  (b) Blaise Pascal  (c) William Oughtred  (d) Charles Babbage

8. Which year the Rotating Wheel Calculator was developed?
   (a) 1822 A.D  (b) 1642 A.D  (c) 1633 A.D  (d) 2500 A.D

9. Who invented the device named ‘The Difference Engine’?
   (a) Charles Babbage  (b) Blaise Pascal
   (c) Herman Hallerith  (d) William Oughtred

10. Who is the Father of today’s computer?
    (a) Herman Hellerith  (b) Blaise Pascal
11. Who designed a tabulating machine using punched cards?
   (a) Herman Hollerith  (b) William Oughtred
   (c) Charles Babbage  (d) Blaise Pascal

12. Which year Hollerith Tabulating Machine was designed?
   (a) 1890 A.D  (b) 1633 A.D  (c) 1642 A.D  (d) 1822 A.D

13. The component used in first generation computers is .................
   (a) transistors  (b) vacuum tubes  (c) ICs  (d) micro processor

14. In first generation computer, Input was based on .................
   (a) punched cards  (b) Assembly language
   (c) printouts and paper tubes  (d) punched cards and paper tubes

15. Which one of the following are the examples of first generation computers?
   (a) UNIVAC and Mini computer  (b) ENIAC
   (c) Micro Computer  (d) UNIVAC and ENIAC

16. In second generation computers, the vacuum tubes are replaced by ........
   (a) transistors  (b) integrated circuits
   (c) microprocessors  (d) VLSI

17. Transistors were placed on .........................
   (a) integrated circuits  (b) microprocessors
   (c) silicon chips  (d) vacuum tubes

18. The fifth generation computing devices are based on .............
   (a) internet  (b) artificial intelligence
   (c) high-level languages  (d) VLSI

19. UNIVAC stands for ......................
   (a) Universal Automatic Computing  (b) Universal Auto Computer
   (c) Universal Automatic Computer  (d) Union Automatic Computer

20. In Computer, data is converted into information through ......................
   (a) instruction  (b) processing  (c) data  (d) facts
21. The first generation computers used ………………… for circuitry.
   (a) vacuum tubes  (b) transistors
   (c) integrated circuits  (d) microprocessors

22. Information is …………………
   (a) processed facts  (b) in active  (c) technology based  (d) set of instruction

23. Data are …………………
   (a) processed facts  (b) active  (c) business based  (d) stored facts

24. A set of instructions or procedures for solving problems is defined as …………..
   (a) data  (b) information  (c) algorithm  (d) processing

25. Which one of the following is designed to systematically solve a problem ?
   (a) Information  (b) A computer program
   (c) Algorithm  (d) Data

26. A computer system has ……………..major components.
   (a) 4  (b) 3  (c) 2  (d) 5

27. Software is a set of …………………
   (a) data  (b) raw facts  (c) instruction  (d) information

28. The processing is performed by the …………………
   (a) software  (b) information  (c) data  (d) hardware

29. Which one of the following allows the user to enter the program and data ?
   (a) Processor  (b) Output devices  (c) Input devices  (d) Memory

30. Which of the following is not a input device ?
   (a) Keyboard  (b) Mouse  (c) Scanners  (d) Printers

31. Main Memory is also called …………………
   (a) Secondary memory  (b) Main memory
   (c) CPU  (d) Cache memory

32. Peripheral equipment includes …………………
   (a) input device  (b) output device
   (c) secondary storage device  (d) All of these
33. Software can be classified into …………… categories.
   (a) 5                      (b) 3                      (c) 2                      (d) 4

34. Which one of the following refers to programs that make computer to do something?
   (a) Hardware                (b) Software                (c) Data                (d) Information

35. Which one of the following translates the source program into an object program?
   (a) Operating system        (b) Application software
   (c) Compliers               (d) Hardware

36. A………… is a collection of programs enables to store, modify and extract information.
   (a) Spreadsheet             (b) Word processor
   (c) Database management system (d) Utility programs

37. How many types the computers are classified based on the principle of operation?
   (a) 4                      (b) 3                      (c) 2                      (d) 5

38. Which is a computing device that work on computing range of values?
   (a) Digital computer        (b) Hybrid computer
   (c) Analog computer          (d) Hardware

39. Digital computer uses …………… number system.
   (a) binary                  (b) decimal                 (c) octal                  (d) hexadecimal

40. A hybrid computers is a combination of …………………
   (a) mini and micro computer (b) Mainframe computers
   (c) mini and micro computer (d) digital and super computer

41. Which one of the following gave birth to the micro computers?
   (a) Super computers         (b) Mainframe computers
   (c) Mini computers           (d) Analog computers

42. Micro computers are classified into …………… types.
   (a) 1                      (b) 2                      (c) 3                      (d) 4

43. PC refers to ……………
   (a) Peripheral computer     (b) Personal computer
   (c) Pocket computer          (d) Peripheral computing
44. CAD stands for ................
   (a) Computer Analysis design   (b) Computer Aided Design
   (c) Color Aided Design         (d) Computing Analysis Design

45. Laptop computer also called ....................
   (a) home computer              (b) pen-based computer
   (c) notebook computer          (d) mini computer

46. Pen-based computers are also called ..............
   (a) home computer              (b) personal digital assistants
   (c) notebook computer          (d) analog computer

47. Super computer process ....................
   (a) hundreds of millions instruction per second
   (b) billions of instruction per second
   (c) 10 million instruction per second
   (d) 1 million instruction per second

48. Mainframes process ....................
   (a) 1 million instruction per second
   (b) 10 million instruction per second
   (c) billions of instruction per second
   (d) hundred on million instruction per second

49. Raw data is processed by the computer into ............
   (a) fact                       (b) information
   (c) Program                   (d) memory

50. Which software allows to credit, edit, format, store, and print text and graphics?
   (a) Spreadsheet                (b) Word processing
   (c) Database management system (d) System software

CHAPTER-2

1. Data can be classified into ............. forms.
   (a) 5   (b) 2   (c) 3   (d) 4

2. Which data can be represented by a series of binary numbers and it is discrete?
   (a) Analog  (b) Video  (c) Text  (d) Digital

3. Which one of the following data are not broken into bits?
   (a) Analog  (b) Digital  (c) Text  (d) Audio

4. Which one of the following are common computer argons?
   (a) Data and fast  (b) Information and data  (c) Bits and bytes  (d) Data and bit
5. The term ‘bit’ stands for ............
   (a) Byte Digit (b) Binary Digit (c) Boolean Digit (d) Byte Information Transmission

6. BHS have only ............ values
   (a) 0 and 2 (b) 1 and 3 (c) 0 and 1 (d) 8 and 5

7. One byte equals ............ Number of bits.
   (a) 8 (b) 16 (c) 256 (d) 255

8. ASCII stand for ............
   (a) American Standard Computer for Information Interchange
   (b) American Standard Code for Information Interchange
   (c) Alpha Standard Code for Information Interchange
   (d) American Standard Code for Interchange Information

9. The ASCII value for a blank character is ............
   (a) 8 (b) 16 (c) 32 (d) 64

10. The ASCII value range for the upper case alphabets is ............
    (a) 0 – 48 (b) 97 to 122 (c) 0 – 127 (d) 65 to 90

11. Computer memory is represented in terms of ............
    (a) kilobyte (b) megabyte (c) byte (d) kilobyte or megabyte

12. One Kilobyte represents ............bytes.
    (a) 1000 (b) 1024 (c) 8 (d) 220

13. How many digit in the binary system?
    (a) 5 (b) 2 (c) 3 (d) 4

14. The radix of a binary system is ............
    (a) 8 (b) 16 (c) 10 (d) 2

15. The leftmost bit in the binary number is called ............
    (a) MSB (b) LSB (c) USB (d) RMB

16. MSB stands for ............
    (a) Middle Significant Bit (b) Medium Size Bit (c) Most Significant Byte (d) Most Significant Bit

17. LSB stands for .............
    (a) Least Significant Bit (b) Lowest Significant Bit (c) Least Significant Byte (d) Lowest Significant Byte

18. The decimal value of 2C₁₆ is .............
    (a) 212₁₀ (b) 24₁₀ (c) 21216₁₀ (d) 44₁₀

19. The radix of an octal number is .............
    (a) 2 (b) 8 (c) 4 (d) 16
20. In binary addition, the operands are called ……………
   (a) augend and operand (b) addend and operand (c) operands (d) augend and addend
21. The 2’s complement of 0 is ……………
   (a) 1 (b) 0 (c) 110 (d) 001
22. Which is used for designing digital circuits in a digital computer?
   (a) Hardware (b) Software (c) Boolean Algebra (d) Integrated Circuits
23. Which is one of the following describe the relation between inputs and outputs of a digital circuit?
   (a) Boolean Algebra (b) Microprocessor (c) Input devices (d) Output devices
24. In AND gate, A and B represented by ……………
   (a) A + B (b) A’B’ (c) A . B (d) A, B
25. A Boolean is a ……………
   (a) Boolean variables and conditions
   (b) Logical operators and variables
   (c) True or False
   (d) Boolean variables and logical operators
26. The basic logical operations can be defined in a form known as ……………
   (a) Truth table (b) Table (c) False Table (d) Boolean Table
27. The AND operator is defined in Boolean algebra by the use of …………… Operator
   (a) dot (b) plus (c) overbar (d) apostrophe
28. In the expression \( Y = A.A \), A represents …………
   (a) AND (b) OR (c) NOT (d) XOR
29. The NOR is a combination of ……………
   (a) NOT and OR (b) NOT and AND (c) AND and OR (d) AND, OR and NOT
30. Which is one of the following is generated by inverting the output of an AND operator?
   (a) OR (b) NAND (c) NOR (D) NOT
31. If A= 1, then A = …………
   (a) 0 (b) A (c) 1 (d) A
32. A …………. Is the appearance of a variable or its complement in a Boolean expression.
   (a) literal (b) product term (c) minterm (d) sumterm
33. A single literal is also a …………
   (a) Minterm (b) sumterm (c) maxterm (d) product term
34. Maxterm is also called ……………
   (a) Sum of products (b) Product of sums (c) Standard maxterm (d) Minterm
35. Sum of Products (SOP) are connected by ……………
36. Which one of the following operations are not commutative?
(a) Addition (b) Subtraction (c) Multiplication (d) Division

CHAPTER-3

I. Choose the correct answer:

1. A computer program is a ............... 
   (a) a predefined set of informations (b) a predefined set of instruction 
   (c) a predefined set of datas (d) a software

2. Which one of the following is a non-physical entities of a computer?
   (a) Data (b) Software (c) Hardware (d) Programs

3. The hardware components include .................. 
   (a) input devices and processor (b) storage and output devices 
   (c) Both (a) and (b) (d) Neither (a) nor (b)

4. Pick out the software item from the following:
   (a) Programs (b) Operating aids (c) Mouse (d) Both (a) and (b)

5. Based on the computer functionality, the hardware components can be classified into ......... 
   (a) 5 (b) 2 (c) 3 (d) 4

6. Which one of the following in not a hardware component?
   (a) CPU (b) Programs (c) Memory unit (d) I/O unit

7. .............. converts the machine coded output results the processor to human understandable form.
   (a) Input device (b) Output device (c) CPU (d) Control unit

8. Which unit of CPU co-ordinates the action of the entire system?
   (a) ALU (b) Memory unit (c) Control unit (d) Input device

9. A pathway between any components of the computer system which allows for data transfer is called .............. .
   (a) data (b) bus (c) devices (d) memory

10. Control unit controls .............. .
    (a) input units (b) memory unit and processor
11. The stored program concept known as .................
   (a) Babbage concept        (b) Von-Neumann concept
   (c) Pascal concept         (d) Hollirith concept

12. The computer uses ............... to accept data and program.
   (a) input devices   (b) output devices   (c) CPU       (d) memory

13. CPU stands for ............... .
   (a) Control Processing Unit   (b) Control Processor Unit
   (c) Central Processing Unit   (d) Central Program Unit

14. ALU stands for ............... .
   (a) Arithmetic Logical Unit   (b) Arithmetic and Logic Unit
   (c) Arithmetic Logical Operation Unit   (d) Arithmetic Logic Union

15. The CPU has ............ major components.
   (a) 6       (b) 2       (c) 3       (d) 8

16. Which one of the following is the computer’s calculator ?
   (a) ALU       (b) Control Unit   (c) Memory       (d) Keyboard

17. The main memory is usually called a ............... .
   (a) Physical memory       (b) Secondary memory
   (c) Primary memory        (d) All of these

18. ROM stands for ............... .
   (a) Random One Memory     (b) Read Only Memory
   (c) Read One Memory       (d) Register Only Memory

19. PROM stands for ............... .
   (a) Program Random Only Memory   (b) Processing Read Only Memory
   (c) Processor Read Only Memory   (d) Programmable Read Only Memory

20. EPROM stands for ............... .
   (a) Erasable Programmable Read Only Memory
   (b) Erasable Program Read Only Memory
21. EEPROM stands for ……………….
   (a) Electronic Erasable Programmable Read Only Memory
   (b) Electronic Erasable Processor Read Only Memory
   (c) Electrically Erasable Programmable Read Only Memory
   (d) Electrically Erasable Processor Read Only Memory

22. Which type of memory in non-volatile in nature?
   (a) ROM  (b) EPROM  (c) PROM  (d) All of these

23. What is used to erase the contents of EPROM?
   (a) Laser light  (b) Ultraviolet light
   (c) Microwaves  (d) Radiowaves

24. Which one of the following is a special type of EEPROM?
   (a) EPROM  (b) PROM  (c) ROM  (d) Flash memory

25. A memory that performs both reads and writes information is called ………….
   (a) ROM  (b) RAM  (c) EPROM  (d) EEPROM

26. The smallest unit of information is called a ……………….
   (a) bit  (b) byte  (c) MB  (d) GB

27. The capacity of a memory system is represented by a unit is called ………….
   (a) Mega Byte  (b) Giga Byte  (c) Byte  (d) Bit

28. Which one of the following known as response time or latency?
   (a) Cycle time  (b) Memory time  (c) Access time  (d) Times

29. Which one of the following is called internal memory?
   (a) RAM  (b) ROM  (c) Registers  (d) Main memory

30. Which one of the following memory closet to the processor?
   (a) Registers  (b) Cache  (c) Main memory (d) Secondary memory

31. Which one of the following is a long term non-volatile memory?
   (a) Main memory  (b) Primary memory

32. The CPU is controlled by ………………. instructions.
   (a) hardware  (b) software  (c) data  (d) memory

33. The performance of the memory system defined by …………….
   (a) Access time  (b) Memory cycle time
   (c) Both (a) and (b)  (d) Registers

34. The most common input device is …………….
   (a) mouse  (b) keyboard  (c) light pen  (d) scanner

35. Which one of the following device controls the movement of the cursor on the display screen?
   (a) Keyboard  (b) Printer  (c) Scanner  (d) Mouse

36. Which one of the following device is very popular in modern computers?
   (a) Mouse  (b) Keyboard  (c) Printer  (d) Scanner

37. Which one of the following device is useful for publishing and multimedia applications?
   (a) OCR  (b) BCR  (c) Scanner  (d) Mouse

38. Scanner is useful for …………….
   (a) desktop publishing  (b) multi-media application
   (c) spreadsheet application  (d) Both (a) and (b)

39. Which one of the following device gives error-free entry of information into the computer?
   (a) Scanner  (b) Bar code reader
   (c) Digital camera  (d) None of these

40. Which one of the following device used to capture images?
   (a) Scanner  (b) MICR  (c) Bar code reader  (d) Keyboard

41. MICR stands for …………….
   (a) Magnetic Ink Character Reader  (b) Memory Ink Character Recognition
   (c) Magnetic Input Character Recognition  (d) Magnetic Ink Character Recognition

42. OCR stands for …………….
   (a) Optical Character Reader  (b) Optical Character Recognition
   (c) Output Character Reader  (d) Output Cache Recognition
43. The Character read by OCR can be edited using .......... .
   (a) word processor                      (b) spreadsheet
   (c) system software                    (d) database management system

44. Which one of the following device is not accurate ?
   (a) OMR                               (b) BCR
   (c) MICR                             (d) Light pen

CHAPTER -4

I. Choose the correct answer :

1. Which one of the following is an elementary building block of the digital circuit ?
   (a) Gate                               (b) Digital gate
   (c) Logic gate                        (d) Physical gate

2. At any moment, logic gate takes one of .............. conditions.
   (a) octal                             (b) binary
   (c) decimal                          (d) logical

3. A voltage level +5V represent a logic ............. .
   (a) 1                                 (b) 0
   (c) +5                               (d) -5

4. The fundamental logic gates are ............. .
   (a) five                              (b) four
   (c) two                              (d) three

5. Which one of the following are called universal gates ?
   (a) AND, OR, NOT
   (b) XOR and XNOR
   (c) NAND and NOR
   (d) NAND and AND

6. The output of AND gate is true, if both inputs are ........ .
   (a) true                              (b) false
   (c) 1                                 (d) 0

7. How many possible inputs to AND gate ?
   (a) 5                                 (b) 2
   (c) 3                                 (d) 4

8. Which sign is used to denote OR functions?
   (a) NAND                              (b) XOR
   (c) NOR                               (d) NOT

9. The NOR gate circuit is an ............. .
   (a) OR gate followed by an inverter
   (b) inverter followed by OR gate
   (c) NOR gate followed by an inverter
   (d) XOR gate followed by an inverter
10. NOR gate can be replaced by ……………….
   (a) OR (b) AND (c) NAND (d) Bubbled AND

11. The NAND gate operates as an …………….
   (a) AND gate followed by NOT (b) Bubbled AND followed by NOT
   (c) AND gate followed by OR (d) AND gate followed by Bubbled AND

12. The exclusive OR operator is …………….
   (a) (b) (c) (d)

13. The XNOR gate is a combination of …………….
   (a) OR gate followed by NOT (b) XOR gate followed by an inverter
   (c) NOR gate followed by an inverter (d) NAND gate followed by NOR

14. The XNOR operator is ……………………. 
   (a) (b) (c) (d)

15. Arrays of logic gates are found in ………………. 
   (a) CPU (b) ALU (c) Memory unit (d) Integrated circuit

16. Which can be used to implement the fundamental logic gates ?
   (a) XOR (b) NAND + NOR
   (c) XNOR (d) Bubbled AND gate

17. How many representation are there in Boolean function ?
   (a) 6 (b) 2 (c) 4 (d) 3

18. Which one of the following list all the values of the Boolean function for each set of values of the variable ?
   (a) Truth table (b) Equation (c) Logic circuit (d) Gates

19. Any Boolean function may be realized using …………… logical operation.
   (a) AND (b) OR (c) NOT (d) All of these

20. How many steps in designing a logic circuit ?
   (a) 2 (b) 4 (c) 6 (d) 12

21. A logical unit that adds three binary digits is called a……………. 
   (a) full adder (b) half adder (c) logical gates (d) gate adder
22. A half adder adds ............ binary digits.
   (a) five   (b) three   (c) four   (d) two

23. A full adder adds ............... binary digits.
   (a) three   (b) two   (c) four   (d) five

24. A half adder sums binary digits to give a ............
   (a) sum   (b) carry   (c) addition   (d) Both (a) and (b)

25. In an half adder truth table, the ‘sum’ column represents the output of ............ gate.
   (a) NOT   (b) XNOR   (c) OR   (d) XOR

26. The carry column is an half adder truth table represent ..............
   (a) NOT   (b) NAND   (c) AND   (d) XOR

27. A full adder sums ............ input bits.
   (a) 3   (b) 2   (c) 5   (d) 4

28. A full adder consists of ............... inputs and ............... outputs.
   (a) 3,2   (b) 2,3   (c) 2,2   (d) 3,3

29. If the logic circuit outputs are base on the inputs, they are called ..............
   (a) sequential circuits   (b) combinational circuits
   (c) digital circuits   (d) flip-flop circuit

30. How many types of sequential circuits ?
   (a) 6   (b) 2   (c) 3   (d) 4

31. Find the odd man out.
   (a) Combinational circuit   (b) Sequential circuit
   (c) Digital circuit   (d) Synchronous sequential circuit

32. Which one of the following is an example of sequential circuit ?
   (a) Flip-flop circuit   (b) Digital circuit
   (c) Logical circuit   (d) Combinational circuit

33. Which one of the following can be used as a basic memory element in a memory device ?
   (a) Logical gates   (b) Logical circuits
   (c) Full adder   (d) Flip-flop
34. A flip-flop circuit can be used be constructed using ………………..
   (a) two NOR gates or two NAND gates
   (b) one NOR gates and one NAND gate
   (c) two NOR gates and one NAND gate
   (d) one NOR gate or two NOT gates

35. A flip-flop is also called ………………
   (a) stable gate
   (b) logic stable gate
   (c) bi-stable gate
   (d) tri-stable gate

CHAPTER-5

I. Choose the correct answer :

1. How many types software are there ?
   (a) 2 (b) 3 (c) 4 (d) 5

2. Which one of the following software looks after the functions of the computer ?
   (a) Application software (b) System software
   (c) Machine language (d) Windows 98

3. Which software makes efficient use of the computing resources ?
   (a) Database software (b) Windows 98
   (c) System software (d) Application software

4. Which one of the following provides many facilities with which a user comfortably uses their computers ?
   (a) Windows 98 (b) System software
   (c) Application software (d) Operating system

5. Which one of the following can access the hardware directly ?
   (a) Circuits (b) Microprocessors
   (c) Operating system (d) Applications

6. Which is the intermediary between the user and computer hardware ?
   (a) Microprocessors (b) Integrated circuits
   (c) Application software (d) Operating system\
7. Operating system serving as a …………….
   (a) System software     (b) Control program
   (c) Operating system     (d) Logical circuits

8. Which one of the following provide date security and data confidentiality?
   (a) System software
   (b) CPU
   (c) Integrated circuits
   (d) Operating system

9. Automatic job sequencing mechanism is called ………….
   (a) circuits
   (b) hardware
   (c) resident monitor
   (d) software

10. The first elementary Operating System is …………….
   (a) MS-DOS
   (b) Resident monitor
   (c) Windows 98
   (d) Unix

11. DMA stands for …………….
    (a) Direct Memory Access
    (b) Digital Memory Access
    (c) Direct Main Access
    (d) Digital Main Access

12. Which one of the following is a way of dealing with dedicated I/O devices in the multiprogramming system?
    (a) DMA
    (b) Memory
    (c) Spooling
    (d) CPU

13. Which one of the following is superior to the buffer?
    (a) Spooling
    (b) DMA
    (c) Scheduling
    (d) Multiprogramming

14. Spooling allowed the CPU to choose a particular job for execution called ………….
    (a) Multiprogramming
    (b) Time-sharing
    (c) Job scheduling
    (d) DMA

15. The job scheduling led to the concept known as the ………….
    (a) spooling
    (b) resident monitor
    (c) time-sharing
    (d) multiprogramming

16. Multiprogramming was followed by ………….
    (a) Job scheduling
    (b) Time-sharing
    (c) Multiprogramming
    (d) Spooling

17. Which one of the following operating system based on the concept of time-sharing?
18. Which one is an example of multi-user operating system?
(a) MS-DOS  (b) Unix  (c) Windows 3.11  (d) Both (a) and (b)

19. Which software does not allocate or de-allocate the files belonging to various users?
(a) System software  (b) Application software  
(c) Multi-user software  (d) Single user software

20. A set of instruction providing an interface between the operating system and the user programs is called
(a) system call  (b) time-sharing  
(c) multiprogramming  (d) spooling

21. Which one of the following is a container for storing files?
(a) System call  (b) Operating system  (c) Directory  (d) File name

22. GUI stands for ............
(a) Graphical User Interface  (b) Graphical User Information  
(c) Graphical User Internet  (d) Graphical User Instruction

23. The GUI is ............... Based.
(a) DOS  (b) Window  (c) Unix  (d) None of these

24. How many types of operating system divides the main memory?
(a) 2  (b) 4  (c) 3  (d) 5

25. Virtual memory is also called ..............
(a) user memory  (b) imaginary memory  
(c) reserved memory  (d) main memory

26. Which one of the following user to allocate the job to the processor?
(a) Job scheduling  (b) Spooling  (c) Algorithms  (d) Interface

27. Which one of the following is a step-by-step method to solve a given problem?
(a) Algorithm  (b) FIFO  (c) SJF  (d) Round Robin

28. Which one of the following algorithm is based on queuing?
(a) SJF  (b) Round Robin  (c) FIFO  (d) GIGO
29. Which queue will conserve memory?
   (a) Bus        (b) Square       (c) Star          (d) Circular

30. FIFO stands for ..........
   (a) First In First Output  (b) First In First Out
   (c) First Input First Output (d) First Input First Out

31. SJF stands for ...........
   (a) Shortest Job First     (b) Software Job First
   (C) Sequence Job First     (d) Software Job Final

32. In which algorithm, jobs are assigned processor time in a circular method?
   (a) FIFO          (b) SJF       (c) Round Robin  (d) Priority

33. The allocation of processors by process management is known as ...........
   (a) job scheduling     (b) CPU scheduling
   (c) multiprogramming   (d) time scheduling

34. How many levels of security provided to the user by an operating system?
   (a) Two               (b) Four          (c) Eight       (d) Three

35. Which level security is offered by the password in a multi-user environment?
   (a) File access level  (b) System level  (c) Network level (d) User level

36. All levels of security are provided only by the ...............
   (a) CPU               (b) Users         (c) Processor    (d) Operating system

37. In which operating system, the entire network behaves as a single computer?
   (a) Linux            (b) Windows XP
   (c) Distributed operating system (d) Unix

38. Which one of the following gives the illusion that many programs run simultaneously?
   (a) Multiprogramming (b) Multiprocessing
   (c) Multitasking     (d) Job scheduling

CHAPTER-6

I. Choose the correct answer:
1. A system consisting of connected nodes is called ............
   (a) devices  (b) computer network
   (c) communication  (d) links

2. Network is a large number of computers are interconnected by ...........
   (a) copper wire  (b) fiber optic cable
   (c) microwave and infrared  (d) All of these

3. Network is to share ............
   (a) data, hardware and software  (b) input devices
   (c) output devices  (d) secondary storage devices

4. Information on a single computer can be accessed by other computers in the network is called .............
   (a) sharing resources  (b) sharing information
   (c) sharing instructions  (d) communication

5. There are ............ general types of networks.
   (a) 5  (b) 2  (c) 3  (d) 4

6. LAN stands for .............
   (a) Logical Area Network  (b) Local Area Network
   (c) Local Analysis Network  (d) Local Area Network

7. MAN stands for .............
   (a) Memory Area Network  (b) Metropolitan Area Network
   (c) Metropolitan Area Node  (d) Memory Analysis Node

8. WAN stands for .............
   (a) Wide Area Network  (b) Web Area Network
   (c) Web Area Node  (d) Wide Analysis Node

9. Which one of the following network do not use telephone network?
   (a) LAN  (b) MAN
   (c) WAN  (d) Communication network

10. LANs are connected by .............
11. In a wireless LAN, connections by using ............
   (a) Audio waves          (b) Infrared waves
   (c) Infrared or radiowaves  (d) Microwaves

12. LAN is generally used to share ..............
   (a) hardware        (b) software
   (c) data            (d) All the above

13. A network that spans a geographical area covering a metropolitan city is called ...........
   (a) LAN        (b) MAN      (c) WAN
   (d) Internet

14. A WAN is typically two or more ............ connected together across a wide geographical area.
   (a) LANs         (b) MANs
   (c) computers      (d) resources

15. A layout of the communication channels that connects various computers on the network is called ...........
   (a) communication network
   (b) network topology
   (c) network structure
   (d) network layout

16. Each computer in the network is called a .............
   (a) remote computer
   (b) channel
   (c) node
   (d) communication

17. The number of topologies used in the network is .................
   (a) 2      (b) 5     (c) 3
   (d) 7

18. Which one of the following is not a network topology?
   (a) Star         (b) Bus
   (c) Ring          (d) Channel

19. UTP stands for ..............
   (a) Unshielded Twisted Pair
   (b) Unshielded Twisted Pair
   (c) Universal Twisted Pair
   (d) Unshielded Twisted pointer

20. In which network, computers are connected to cable?
   (a) Star         (b) Ring
   (c) Bus          (d) FDDI

21. Hybrid network is a combination of .............
(a) star and ring network  
(b) ring and FDDI network  
(c) star, bus and ring network  
(d) star and FDDI network  

22. FDDI stands for .............
(a) Fibre Distributed  
(b) First Distributed data interface  
(c) Fiber data Distributed  
(d) Fibre distributed Data information  

23. Which one of the following network is a high-speed network?
(a) Hybrid  
(b) Star  
(c) Ring  
(d) FDDI  

24. All types of networks require ............elements.
(a) 2  
(b) 3  
(c) 4  
(d) 5  

25. Network services are provided by combinations of .............  
(a) Hardware and Software  
(b) Data and Information  
(c) Data and Hardware  
(d) Information and Software  

26. Which one of the following allows networked devices to contact each other in transmission media?
(a) Cables and wireless technologies  
(b) Cables only  
(c) Wireless network  
(d) Network topologies  

27. Which one of the following is a set of rules that allow different devices to hold conversations?
(a) Network topologies  
(b) Network services  
(c) Transmission media  
(d) Protocols  

28. Which one of the following are well suited to control data storage activity on different storage systems?
(a) Network Applications  
(b) Network Services  
(c) Network Topologies  
(d) Message Database  

29. Data moved from one storage media to less expensive media is called ...........  
(a) data storage  
(b) data migration  
(c) network data  
(d) data sharing  

30. File archiving is also called
(a) file transfer  
(b) file sharing  
(c) file backup  
(d) file services  

31. Which one of the following is safe when storage devices are connected in the network?
(a) File transfer  
(b) File storage  
(c) File update synchronization  
(d) File archiving
32. Message services deals with …………. 
   (a) documents 
   (b) users applications 
   (c) network applications or documents 
   (d) users application, network application or documents 

33. Which one of the following services allow computers to share processing power? 
   (a) Application services 
   (b) File services 
   (c) Print services 
   (d) Message services 

34. NIC stands for …………. 
   (a) Network Interface Card 
   (b) Network Information Code 
   (c) Node Interface Card 
   (d) Network Instruction Card 

35. Which one of the following device that co-ordinates data transfer from one computer to other? 
   (a) Input device 
   (b) Output device 
   (c) NIC 
   (d) Network device 

36. Example for the NIC …………. 
   (a) Ethernet, Arenet 
   (b) Arenet, token ring 
   (c) Ethernet, token ring 
   (d) Ethernet, Arenet, token ring 

37. In which year protocol was proposed by International standards organization? 
   (a) 1968 
   (b) 1988 
   (c) 1978 
   (d) 1998 

38. OSI stands for …………. 
   (a) Open System Interconnection 
   (b) Open System Internet 
   (c) Output System Interconnection 
   (d) Open System Interface 

39. How many layers the OSI provided? 
   (a) 5 
   (b) 6 
   (c) 7 
   (d) 8 

40. Which one of the following data transmission is the widely used communication in the world? 
   (a) Analog 
   (b) Digital 
   (c) Ring 
   (d) Star 

41. The device that accomplishes modulation – demodulation process is called a …………. 
   (a) NIC 
   (b) OSI 
   (c) Modem 
   (d) Output devices 

42. DCE stands for …………. 

22
(a) Data Circuit Equipments  (b) Digital Circuit Equipments
(c) Digital Circuit Terminating Equipments  (d) Data Circuit Terminating Equipments

43. A modern as automatic and dialing functions is called ............
   (a) Efficient modems  (b) Effective modems
   (c) Intelligent modems  (d) Extraordinary modems

44. BPS stands for ..............
   (a) Bytes Per second  (b) Bits Per Second
   (c) Bytes Per second  (d) Bits Per System

45. The rate at which the data transferred is expressed in terms of ............
   (a) BBS  (b) BPS  (c) BITS  (d) BYTE RATE

46. In how many modes, the data transmission occur ?
   (a) 5  (b) 2  (c) 3  (d) 4

47. In which mode of data transmission communication is faster ?
   (a) Simplex mode  (b) Full duplex
   (c) Half duplex  (d) Half and full duplex

48. IP stands for ..............
   (a) Internet Processing  (b) Information Protocol
   (c) Internet Programming  (d) Internet Protocol

49. TCP/IP made of ............... components.
   (a) 5  (b) 2  (c) 3  (d) 4

50. In TCP/IP, TCP stands for ..............
   (a) Transmission Control Protocol  (b) Terminating Control Protocol
   (c) Transmission Circuit Protocol  (d) Transmission Control Processing

51. ICANN stands for ..............
   (a) Internet Corporation for Assigned Names and Numbers
   (b) Internet Corporation for Assigned Numbers and Names
   (a) Internet Corporation for Assigned Names and Network
   (a) Internet Corporation for Assigned Numbers and Network
52. WWW stands for …………… .  
   (a) World Wide Web  (b) Wide World Web  
   (c) Web Wide World  (d) Wide Web World  

53. Each page of a Internet is called a …………… .  
   (a) page  (b) home page  (c) web page  (d) web site  

54. The first page of the web site is called a …………… .  
   (a) web page  (b) web site  (c) WWW  (d) home page  

55. Every web page has a unique address called the………. .  
   (a) WWW  (b) URL  (c) TCP/IP  (d) HTTP  

56. URL stands for ………………….  
   (a) Uniform Resource Location  (b) Universal Resource Locator  
   (c) Uniform Resource Locator  (d) Uniform Resource Locator  

57. HTTP stands for …………. .  
   (a) Hypertext Transmission Procedure  (b) Hypertext Transfer Procedure  
   (c) Hypertext Transfer Protocol  (d) Hypertext Transmission Protocol  

58. Looking for information of the internet is called …………. .  
   (a) surfing  (b) viewing  (c) browsing  (d) surfing or browsing  

59. Which one of the following software is used to browse the Internet ?  
   (a) Web site  (b) Web browser  (c) Web page  (d) Web page editors  

60. Which one of the following translates HTML documents of the web site and allows to view it on the screen ?  
   (a) HTML  (b) HTTP  (c) TCP/IP  (d) Web browser  

61. FTP stands for ……………. .  
   (a) File Transfer Protocol  (b) File Transmission Protocol  
   (c) File Transfer Procedure  (d) File Transmission Procedure  

62. Which protocol allows the user to connect to a remote computer ?  
   (a) HTTP  (b) Telnet  (c) TCP/IP  (d) FTP  

63. How many ways to look for the information on the web ?
64. Which one of the following button helps to reload the web page faster?
   (a) Stop  (b) Home  (c) Refresh  (d) Back

65. A private network uses TCP/IP and other Internet standard protocol called…………... .
   (a) Internet  (b) Intranet  (c) Extranet  (d) Internet and Intranet

66. The main consideration of the intranet is…………... .
   (a) sharing  (b) transfer  (c) security  (d) resource sharing

CHAPTER-7

I. Choose the correct answer:

1. Which of the following is a user-friendly operating system?
   (a) Windows XP  (b) UNIX  (c) MS-DOS  (d) LINUX

2. The most important advantage of using Windows XP is its…………... .
   (a) desktop  (b) window  (c) icons  (d) GUI

3. GUI pronounced as ........... .
   (a) GOOI  (b) GUYEE  (c) GOOYEE  (d) GUI or GOOI

4. MS-DOS use ........... .
   (a) CUI  (b) GUI  (c) Commands  (d) Interface

5. Which of the following is the introduced the concept of window?
   (a) Apple  (b) Microsoft
   (c) Sun microsystem  (d) Borland International

6. The first version of Windows is ........... .
   (a) window 3.1  (b) windows 3.0  (c) windows 3.1  (d) windows 0.3

7. Windows NT stands for ........... .
   (a) Windows Network  (b) Windows Network Technology
   (c) Windows New Technology  (d) Work Network Technology

8. The mouse has ........... . buttons on the top.
9. Which of the following mouse action is used to select objects on the windows screen?
   (a) Move  (b) Click  (c) Double-click  (d) Click and drag

10. Which of the following mouse action is used to start applications?
    (a) Double-click  (b) Click  (c) Move  (d) Click and drag

11. Which of the following mouse action provided context sensitive menu?
    (a) Left click  (b) Click  (c) Right click  (d) Double-click

12. Context sensitive menu is also called …………….
    (a) Program menu  (b) Short cut menu  (c) File handling menu  (d) Application menu

13. The key equivalent to double-click mouse action is …………….
    (a) 5  (b) /  (c) *  (d) +

14. Which of the following is equivalent to select the right mouse button?
    (a) Insert  (b) Alt  (c) Ctrl  (d) -

15. The key equivalent to release the locked button is …………….
    (a) Alt  (b) Insert  (c) Delete  (d) Backspace

16. Which of the following key is equivalent to select both mouse buttons?
    (a) *  (b) 5  (c) -  (d) /

17. Icon literally means a …………….
    (a) desktop  (b) window  (c) statue  (d) BARS

18. Which of the following key combinations provide the dialog box for entering the user name and password?
    (a) Ctrl + Alt + Insert  (b) Ctrl + Alt + Delete  (c) Ctrl + Alt + Del  (d) Alt + Ctrl + Del

19. Which key lies between Ctrl and Alt keys?
    (a) Esc  (b) Insert  (c) Delete  (d) Winkey

20. The key used to log off the computer is …………….
    (a) L or U  (b) I and L  (c) U  (d) L or I

21. The key used to turn off the computer is …………….
22. The key combinations used to turn off the computer is ………………….
   (a) Alt + F4          (b) Ctrl + F4          (c) Alt + Esc          (d) Alt + Ctrl + F4

23. The Hibernate button is ………………. 
   (a) Alt + Click       (b) Ctrl + Click       (c) Shift + Click       (d) Insert + Click

24. The desktop contains ………………. 
   (a) windows          (b) icons            (c) taskbar           (d) icons and taskbar

25. How many different start menus in Windows XP? 
   (a) 1         (b) 2         (c) 3         (d) 4

26. The right arrow in start menu indicates ………………. 
   (a) main menu       (b) windows menu     (c) sub menu          (d) desktop menu

27. Which of the following key used to select start menu in windows XP? 
   (a) Ctrl + Tab     (b) Ctrl + Alt + Del (c) Ctrl + Esc     (d) Alt + F4

28. Which character is used to highlight all programs menu in windows XP? 
   (a) A        (b) P        (c) G        (d) S

29. Which of the following is a simple word processor package? 
   (a) MS-Word   (b) StarWriter   (c) WordPad    (d) AMIPRO

30. In windows XP at the top of each window is the …………. 
   (a) Title Bar   (b) Tool Bar   (c) Menu Bar    (d) Status Bar

31. In windows title bar the number of sizing buttons are ……………. 
   (a) 2     (b) 3     (c) 4     (d) 3 and 4

32. Which of the following button is used to close the window? 
   (a) Minimize   (b) Close   (c) Restore   (d) Exit

33. Which of the following consist of icons representing shortcuts for the most frequently used commands? 
   (a) Title bar   (b) Menu bar   (c) Status bar   (d) Tool bar

34. The key combinations used to save the file in WordPad is ……………. 
   (a) Ctrl + s   (b) Alt + S   (c) Shift + S   (d) Ctrl + Alt + S
35. Which of the following is used to move the window to different area of the desktop?
   (a) Menu bar  (b) Tool bar  (c) Sizing buttons  (d) Title bar

36. Which of the following is an inter-active operating system?
   (a) MS-DOS  (b) UNIX  (c) Windows XP  (d) Linux

37. Which of the following control is used to allow the user to enter data in a dialog box?
   (a) Text boxes  (b) List boxes  (c) Radio Buttons  (d) Combo boxes

38. In radio button options, the user can select ............ options.
   (a) only one  (b) only two  (c) only four  (d) many

39. In check boxes, the user can select ............. option.
   (a) only one  (b) only two  (c) only three  (d) many

40. Which of the following buttons are the most frequently buttons used in Windows XP?
   (a) Retry and Cancel  (b) OK and Cancel  (c) Abort and Ignore  (d) YES and NO

41. Which of the following buttons are used to display different sets of options in dialog boxes?
   (a) Radio buttons  (b) Check boxes  (c) Tabs  (d) Command buttons

42. Which key combinations will take the user to the Help and support system of Windows XP?
   (a) Winkey  (b) Alt + F4  (c) Winkey + F1  (d) Alt + F4

43. Which of the following color underlined text will provide the definition of the term in XP help?
   (a) Green  (b) Red  (c) Blue  (d) Purple

44. Which of the following is the first button in the navigation bar of Help and support center in XP?
   (a) Home  (b) History  (c) Support  (d) Back

45. Which of the following button stores a list of help pages that is recently visited by the user?
   (a) Support  (b) History  (c) Forward  (d) Home

46. Which button is used to redisplay the help pages in XP?
   (a) Home  (b) History  (c) Support  (d) History and Home

47. The default number of search results provided by Help and support center is ..............
48. The command used to get help from Microsoft website is ............ .
   (a) XP + folder       (b) XP + folder + view      (c) XP + view + folder  (d) View + folder
49. By default, the taskbar displayed at the ........... of the desktop.
   (a) Button         (b) Top                     (c) Left                 (d) Right
50. In Windows XP, the user can arrange the window in ............ ways.
   (a) 2              (b) 3                      (c) 4                    (d) 2 or 3
51. How many views control paper provides?
   (a) 3          (b) 4                      (c) 5                    (d) 2
52. Which icon on the control panel allows the user to change the appearance of the desktop?
   (a) Accessibility options  (b) Mouse          (c) Keyboard          (d) Display
53. Windows XP allows you to customize the .............
   (a) desktop and taskbar    (b) desktop and title bar
   (c) taskbar and window     (d) desktop only
54. The clock is displayed on the ...................
   (a) title bar         (b) menu bar          (c) task bar           (d) tool bar
55. Which icon on the control panel allows the user to view, add or remove fonts?
   (a) Fonts            (b) Display           (c) Keyboard          (d) Mouse
56. In Windows, files are broadly classified into ............. categories.
   (a) two              (b) three             (c) four               (d) sixteen
57. Application files also called ............
   (a) document files   (b) system files    (c) program files      (d) folders
58. Before Windows XP, which of the following was very popular operating system among PC users.
   (a) MS-DOS          (b) UNIX              (c) LINUX             (d) MS-DOS & UNIX
59. Which of the following is the MS-DOS option used in Windows XP?
   (a) MS-DOS prompt   (b) DOS              (c) MS-DOS            (d) command prompt
60. How many modes calculator can be used in XP?
   (a) Two             (b) Three            (c) Five              (d) Four
61. Which of the following is an Application is used to draw and color pictures?
   (a) Command prompt   (b) Notepad   (c) WordPad   (d) Paint

62. Which key combinations is used to close the Application window?
   (a) Alt + F4   (b) Ctrl + F4   (c) Shift + F4   (d) Ctrl + Tab

63. Which of the following indicates the current position on the wordpad screen?
   (a) Cursor   (b) Mouse pointer   (c) Tool bar   (d) Status bar

64. Which key on the keyboard is used to start a new paragraph?
   (a) Shift   (b) Enter   (c) Tab   (d) Ctrl

65. Which of the following key is used to move the cursor to Beginning of the line?
   (a) Home   (b) Ctrl + Home   (c) Shift + Home   (d) Alt + Home

66. Which of the following key is used to move the cursor to the end of the document?
   (a) End   (b) Ctrl + Home   (c) Ctrl + End   (d) Home

67. The key is used to move the cursor to the beginning of the document?
   (a) Home   (b) Ctrl + Home   (c) Alt + Home   (d) Shift + Home

68. The key is used to move the cursor to top of next page?
   (a) Ctrl + PgUp   (b) Shift + PgUp   (c) Shift + PgDn   (d) Ctrl + PgDn

69. Which of the following key deletes the character before the cursor?
   (a) Delete   (b) Backspace   (c) Shift + Delete   (d) Shift + Backspace

70. The key deletes the character after the cursor is ……..
   (a) Delete   (b) Backspace   (c) Shift + Delete   (d) Alt + Delete

71. Which of the following key will take the user to overwrite mode?
   (a) Alt + Ins   (b) Shift + Ins   (c) Insert   (d) Ctrl + Ins

72. How many applications start at a time in Windows XP?
   (a) Two   (b) Sixteen   (c) 256   (d) Many

73. Which of the following is used to switch between the different applications?
   (a) Title bar   (b) Task bar   (c) Status bar   (d) Tool bar

74. The currently used application window is called the ..........?
   (a) Default window   (b) Desktop window   (c) Active window   (d) Application window
75. Which of the following is a temporary storage for data being copied or moved.

(a) Task bar  (b) Clipboard  (c) Window  (d) Desktop

76. In Paint the …………… tool is used to mark the picture to be copied or moved.

(a) select  (b) cut  (c) copy  (d) mark

77. The shortcut key is used to move the picture in paint is …….. .

(a) Ctrl + C  (b) Ctrl + X  (c) Ctrl + M  (d) Ctrl + V

78. To close the wordpad application by clicking on exit in the menu called. …………… .

(a) file  (b) edit  (c) exit  (d) format.

CHAPTER-8

I. Choose the correct answer:

1. Every file, is identified by using a(n) …………… .

(a) information  (b) file name  (c) unique name  (d) instruction

2. A file name is made up of …………… components.

(a) two  (b) three  (c) four  (d) many

3. The first part of the file name is ……………

(a) unique name  (b) main component  (c) extension  (d) file

4. Main component is also called …………….

(a) unique name  (b) extension  (c) secondary name  (d) file

5. Which of the following separates main component and extension ?

(a) Decimal point (.)  (b) Plus (+)

(c) Astrikes (*)  (d) Underscore (_)

6. Which of the characters that a file name cannot contain?

(a) @ and $  (b) { and [  (c) * and ?  (d) ! and @

7. The second part of the file name is …………..

(a) main component  (b) unique name

(c) primary name  (d) extension

8. The extension is normally up to ………….. characters long.
9. The file name can be a maximum of …………… characters long.
   (a) 8          (b) 256          (c) 16          (d) 255

10. Which part of the file name announces the format in which the data in the file is stored?
    (a) Main component          (b) Primary name
    (c) Application name        (d) Extension

11. In DOS-based computers, the main component of file can have a maximum of …………… characters.
    (a) 255          (b) 8          (c) 256          (d) 16

12. In DOS-based computers, the extension of files cannot exceed more than …………… characters.
    (a) 3          (b) 4          (c) 8          (d) 16

13. Windows XP allows the user to organize the files into ………………….
    (a) file names          (b) Windows Explorer
    (c) Control panel        (d) folders

14. Which of the following is not a part of Windows Explorer?
    (a) Title bar          (b) Menu bar          (c) Task bar          (d) Tool bar

15. If the user opens up to four folders, separate buttons are create on the ………………….
    (a) title bar          (b) task bar          (c) tool bar          (d) menu bar

16. What is the name of the button on the task bar if the user opens five folders in Windows Explorer?
    (a) Folders          (b) Files
    (c) Windows explorer          (d) Explorer

17. The disk drives on the computer are treated as………………
    (a) drives          (b) files          (c) folders          (d) menu bar

18. Which sign indicates the presence of sub folders in Windows Explorer?
    (a) *          (b) +          (c) /          (d) [ ]

19. Which of the following is used to browse the list of folders in Windows Explorer?
    (a) Tool bar          (b) Status bar          (c) Scroll bar          (d) Menu bar

20. In Windows XP, Windows Explorer have ………….. types of views of files and folders.
21. In which view of Windows Explorer the files and folders are displayed in columns?
(a) Icons view  
(b) Filmstrip view  
(c) Thumbnails view  
(d) List view

22. To create new folder from the menu bar .................
(a) File → New → Folder  
(b) New → Folder → File  
(c) File → Folder → New  
(d) Folder → New → File

23. The key used to select the files or folders consecutively is ..............
(a) Ctrl  
(b) Alt  
(c) Shift  
(d) Tab

24. Which of the following key is used to select the files or folders not consecutively?
(a) Tab  
(b) Shift  
(c) Alt  
(d) Ctrl

25. The menu used to do cut, copy and paste is ............... 
(a) File  
(b) Edit  
(c) Tools  
(d) Format

26. The short cut key used to do cut, copy and paste is ............... 
(a) Ctrl + X, Ctrl + C and Ctrl + V  
(b) Ctrl + X, Ctrl + C and Ctrl + P  
(c) Ctrl + C, Ctrl + X and Ctrl + V  
(d) Ctrl + V, Ctrl + X and Ctrl + C

27. The option from the Edit menu to move the selected items using Explorer bar is ........... 
(a) Edit → Move  
(b) Edit → Folder Move  
(c) Edit → File and Folder Move  
(d) Edit → Move To Folder

28. The option from the Edit menu to Copy the selected items using Explorer bar is ............... 
(a) Edit → Copy  
(b) Edit → Copy To Folder  
(c) Edit → Folder To Copy  
(d) Edit → Copy Folder

29. How many pages in a clipbook?
(a) 24  
(b) 128  
(c) 127  
(d) 130

30. The clipbook gets items through the..............
(a) Applications  
(b) Clipboard  
(c) Documents  
(d) Files

31. How many types of CD burners available?
(a) 4  
(b) 3  
(c) 1  
(d) 2
32. How many types of blank CDs available?
   (a) 4  (b) 2  (c) 1  (d) 3

33. CD-RW burner is used to burn data to a ……………… .
   (a) CD-R  (b) CD-RW  (c) CD-W,CD-R  (d) CD-RW or CD-R

34. How many ways to Rename the files or folders in Windows XP?
   (a) 2  (b) 3  (c) 4  (d) 1

35. Which of the following menu is used to rename the file or folder?
   (a) File  (b) Edit  (c) Tools  (d) Format

36. The key combination used not to send the deleted files or folders to the Recycle Bin is………..
   (a) Alt + Delete  (b) Shift + Delete  (c) Ctrl + Delete  (d) Alt + Tab

37. How many kinds of shortcuts is Windows XP?
   (a) 4  (b) 3  (c) 6  (d) 2

38. Which of the following key is not used as a shortcuts in XP?
   (a) Esc, Enter  (b) Esc, Spacebar
   (c) Enter, Shift  (d) Esc, Enter, Spacebar, Shift

39. The wild card entries in a search dialog box is …………….. .
   (a) *,>  (b) ?,<  (c) ?,*  (d) <,*

40. The wild card entry (*) in a search dialog box stands for …………… .
   (a) single letter  (b) zero letters
   (c) two letters  (d) zero or more letters

41. In Run command, the drive, folder names and file name are all separated by …………… .
   (a) /  (b) ?  (c) \  (d) *

42. In Windows XP, the start menu appears as a panel containing ………. columns(s)?
   (a) 3  (b) 4  (c) 1  (d) 2

43. The status area means ……………….. .
   (a) Document  (b) Window  (c) Desktop  (d) System tray

44. Which key toggles the display of the start menu?
   (a) Winkey  (b) Alt  (c) Shift  (d) Ctrl
45. The key used to displays the desktop ................. .
   (a) Winkey + B    (b) Winkey    (c) Winkey + D    (d) Alt + F4

46. Which key more the focus to the notification area ?
   (a) Winkey + N    (b) Winkey + B    (c) Winkey + A    (d) Winkey + F1

47. Which key activate search companion ?
   (a) Winkey + F    (b) Winkey + S    (c) Winkey + A    (d) Winkey + F2

48. The key used to starts a search for computer is ................. .
   (a) Winkey + F    (b) Winkey + Alt + F
   (c) Winkey + A1 + F1    (d) Winkey + Ctrl + F

49. Which of the following key issues an undo minimize all command ?
   (a) Winkey + M    (b) Winkey + Shift + M
   (c) Winkey + Ctrl + M    (d) Window + Alt + M

50. ASR stands for ...................... .
   (a) Automated System Recovery    (b) Auto System Reading
   (c) Automatic System Reader    (d) Automatic Solution Recovery

51. The literal meaning of virus is .......................
   (a) Vital    (b) Information    (c) Resource files    (d) Poison

52. Computer virus program designed to damage .......................
   (a) software and data    (b) hardware or data
   (c) data or programs    (d) software, hardware and data

53. How many basic flavours in computer virus ?
   (a) Two    (b) Three    (c) Four    (d) Many

54. Which of the following is a program to safeguard system from the virus ?
   (a) Ultra virus    (b) Antivirus    (c) Trojan horses    (d) Micaelangeto

55. The key combinations used to select all the objects in the folder is ...................... .
   (a) Ctrl + Z    (b) Ctrl + X    (c) Ctrl + A    (d) Ctrl + V

56. Which function key is used to rename the selected object ?
   (a) F1    (b) F2    (c) F3    (d) F4
57. The function key displays the find dialog box is …………….. 
   (a) F3    (b) F2    (c) F4    (d) F5

58. Which function key refreshes the Explorer window? 
   (a) F3    (b) Shift + F2    (c) F9    (d) F5

59. The function key displays the context menu for the selected objects in XP is …………….. 
   (a) F10    (b) Shift + F10    (c) F9    (d) Shift + F9

CHAPTER-9

I. Choose the correct answer:

1. University of Helsinki students used a version of Unix called …………….. 
   (a) Windows 98    (b) Linux    (c) Linus    (d) Minix

2. In which year Linux was introduced? 
   (a) 1991    (b) 1990    (c) 1989    (d) 2000

3. The first released version of Linux was …………………. 
   (a) 0    (b) 0.1    (c) 0.11    (d) 1.01

4. POSIX stands for …………….. 
   (a) Portable operating system Interface for comput Environments 
   (b) Portable Operating System Information for Comput Environments 
   (c) Poratable Operating System Instruction for Comput Environments 
   (d) Portable Operating System Interface for Comput Environments

5. Which of the following is specially designed for Intel-based PCS? 
   (a) Minix    (b) Unix    (c) Linux    (d) Posix

6. How many versions for each release Linux? 
   (a) 3    (b) 2    (c) 1    (d) 4

7. Linux 2-2-5 version is a …………….. 
   (a) beta version    (b) trial version 
   (c) stable version    (d) stable and beta version

8. The command prompt will end the user current Linux session is ……………….
9. The command used to change the login password in Linux is ..............
   (a) pwd        (b) password       (c) pword       (d) passwd

10. The login password should not be less than .............. characters in length.
    (a) 2           (b) 3             (c) 6           (d) 4

11. A file is a collection of ..............
    (a) folder      (b) entity        (c) records     (d) programs

12. A record gives information about ..............
    (a) folder      (b) file          (c) program     (d) entity

13. The home directory is written as ..............
    (a) \home         (b) \root       (c) / root       (d) / home

14. The is no parent directory for the ..............
    (a) user directory (b) home directory (c) root directory (d) user and home directory

15. In Linux, the file name can be up to .............. characters.
    (a) 8           (b) 255          (c) 16          (d) 256

16. If a file starts with a period is called a ..............
    (a) root file    (b) home file     (c) dot file     (d) period file

17. Who is primarily responsible for the smooth functioning of the system in Linux?
    (a) System Administrator (b) File owner
    (c) Group owner           (d) System Administrator or the Root user

18. In Linux, System Administrator is also known as the ..............
    (a) file owner or root user (b) root user or super user
    (c) file owner of super user (d) group owner or super user

19. In Linux, the prompt for the root user is ..............
    (a) $             (b) @            (c) #            (d) !

20. The user who creates a file is said to be the ..............

37
21. In Linux, abbreviation for list is …………..
   (a) li (b) It (c) Is (d) st

22. The command starts with a(n) …………..
   (a) number (b) period (c) alphabet (d) underscore

23. The general format of command in Linux is …………..
   (a) command argument option (b) command option argument
   (c) option command argument (d) argument option command

24. Which of the following sign distinguishes an option from command and argument?
   (a) +(plus) (b) -(minus) (c) / (slash) (d) + or –

25. How many bins and personal directions in Linux?
   (a) 2 (b) 4 (c) 3 (d) 5

26. In Linux, path names are of ………….. types.
   (a) 4 (b) 3 (c) 2 (d) many

27. Which of the following denote the path of parent directory?
   (a) + (b) - (c) . (d) ..

28. Which command will create a directory in Linux?
   (a) md (b) mkdir (c) mdir (d) cdmod

29. Which option used with ls to display hidden files /
   (a) –l (b) –a (c) –f (d) –R

30. Which of the following command is used to clear the screen?
   (a) clear (b) cls (c) tputclear or clear (d) tputclear

31. In echo –n, the option -n display the cursor in …………..
   (a) same line (b) next line (c) previous line (d) end of the line

32. How many types of files in Linux?
   (a) 5 (b) 4 (c) 3 (d) 2

33. Which of the following are the types of Linux files?
(a) Ordinary files and special files  
(b) Directory files and Special files  
(c) Directory files and ordinary files  
(d) Ordinary files, directory files and special files  

34. Which of the following command is used to show the contents of the file page by page in Linux?  
(a) cat  
(b) man  
(c) pwd  
(d) echo  

35. The standard type of file in Linux is……………… .  
(a) byte stream file  
(b) bit stream file  
(c) kilobyte stream file  
(d) byte system file  

36. Linux considers the screen and the keyboard as  .  
(a) bytes  
(b) files  
(c) folders  
(d) bits  

37. The input redirection operator is  .  
(a) <<  
(b) |  
(c) <  
(d) >  

38. Which of the following operator appends (add) the contents of the file?  
(a) >  
(b) <  
(c) <<  
(d) >>  

39. The standard input is connected to the  .  
(a) keyboard  
(b) printer  
(c) cd  
(d) floppy disk  

40. Which command denotes the end-of-file character for Linux file?  
(a) Ctrl + F  
(b) Ctrl + D  
(c) Ctrl + E  
(d) Alt + D  

41. Which of the following is a storage medium to store the data?  
(a) Command  
(b) Files  
(c) Folders  
(d) Operators  

42. Ipr stand for  .  
(a) line printer  
(b) line print  
(c) line print reader  
(d) low print  

43. The piping symbol is  .  
(a) |  
(b) !  
(c) >  
(d) –n  

44. Which of the following command plays dual role?  
(a) n  
(b) -1  
(c) 1  
(d) –n  

45. Which of the following command plays dual role?
46. The tee command will split the file into .......... copies.
   (a) three (b) four (c) two (d) three or four

47. To add option in the cp command for getting a warning from the system before over writing is 
  ..............
   (a) -r (b) -l (c) –i (d) –n

48. Which of the following special characters Linux provides to have partial information about the 
  filenames?
   (a) *and? (b) ? and [ ] (c) ( ) (d) < >

49. The key combinations used to erase the characters in a command line is ............... 
   (a) Ctrl + B (b) Ctrl + H 
   (c) Ctrl + H and Delete key (d) Delete key and Ctrl + U

50. Which of the key combinations used to deletes the entire line
   (a) Ctrl + U (b) Ctrl + H (c) Ctrl + F (d) Ctrl + B

51. To enter more than one command in the same command line, the symbol used to separate them 
  ..............
   (a) (dot) (b) ..(double dot) (c) ;(semicolon) (d) ,(comma)

52. Which of the following is not a option of mv command?
   (a) –i (b) –v (c) –f (d) –s

53. The option used with date on display time in the AM/PM notation is ............... 
   (a) %T (b) %t (c) %r (d) TR

54. The option used with date to display as abbreviated month is ............... 
   (a) % M (b) %m (c) % H (d) %h

55. How many number of arguments used with mount command?
   (a) Three (b) Four (c) Two (d) Six

56. The Command formats a floppy disk is ............
   (a) mount (b) umount (c) mkfs (d) format

57. Which of the following command used to position the cursor on a specified row and column?
   (a) tput clear (b) tput cup (c) mount (d) cat-n
58. Editors are mainly used for …………… .
   (a) creating and deleting  
   (b) deleting and editing  
   (c) creating and editing  
   (d) creating, deleting and editing

59. Which of the following are standard editors ?
   (a) MS-DOS  
   (b) Notepad and Vi  
   (c) Ed and Vi  
   (d) Notepad and Ed

60. Using Editors, which of the following key in the keyboard used to input ?
   (a) Alphabetic character keys  
   (b) Control keys  
   (c) Functional keys  
   (d) Special keys

61. Using Editors, which of the following key in the keyboard used to edit commands ?
   (a) Control keys  
   (b) Functional keys  
   (c) Alphabetic character keys  
   (d) control keys and functional keys

62. What are the modes of Vi editor ?
   (a) Linc-editing modes  
   (b) Command mode and input mode  
   (c) Input modes  
   (d) Output mode and Input mode

63. Which of the following action saves your file and exits Vi editor ?
   (a) Shift + ZZ  
   (b) Ctrl + ZZ  
   (c) Alt + ZZ  
   (d) Ctrl + Alt + Z

64. Which of the following is used to quit Vi editor ?
   (a) ;w  
   (b) :q  
   (c) .q  
   (d) :q

65. To set the word wrap margin, the command to do so by …………… .
   (a) :set  
   (b) :set w = col  
   (c) :set wm  
   (d) :set wm = col

66. Which of the following key deletes a single character in the command mode ?
   (a) a  
   (b) j  
   (c) x  
   (d) k

67. Which of the following command to copy a line in Vi editor ?
   (a) dd  
   (b) yy  
   (c) ndd  
   (d) nyy

68. Which of the following is used to search the pattern, forward the text in Vi Editor ?
   (a) /  
   (b) \  
   (c) *  
   (d) ?

69. Which of the following is used to search the pattern, backward in the text in Vi Editor ?
70. Which of the following is a text file that contains Linux commands?
   (a) Shell script (b) Document script
   (c) Text script (d) Shell document

71. The default shell of the Linux system is …………..
   (a) sh (b) login shell (c) BASH (d) Bourne

72. Which shell has the capabilities of the programming languages?
   (a) sh (b) linux shell (c) login shell (d) BASH

73. Which of the following command is used to execute shell script?
   (a) linux shell (b) login cell (c) sh (d) BASH

74. The variable created within a shell is called a ………………. 
   (a) local variable (b) default variable
   (c) profram variavble (d) shell variable

75. Which of the following is a valid shell variable?
   (a) ab&  (b) a=b (c) a+b (d) a+b

76. Which of the following is most frequently used assignment operator?
   (a) =  (b) *  (c) +  (d) :

77. Which of the following command waits for the user to enter a value for the variable?
   (a) Input (b) Accept (c) Read (d) Scan

78. In Linux, all variables are treated as a ………………. 
   (a) character (b) strings (c) read (d) chmod

79. Which of the following is a multiplicative operator?
   (a) *  (b) /*  (c) *=  (d) */

CHAPTER-10

I. Choose the correct answer:

1. The flowchart and the pseudocode are ………………. 
   (a) intermediate language (b) low-level language
2. How many fundamental control structures are there…………………..
   (a) Two (b) Four (c) Six (d) Three

3. Repeating the set of action again and again is called………………
   (a) sequencing (b) iteration
   (c) branching (d) branching and iteration

4. If the user know the number of times the actions are performed is known as………
   (a) true iteration (b) iteration
   (c) indefinite iteration (d) definite iteration

5. In which iteration only a condition is to be checked?
   (a) indefinite iteration (b) Definite iteration
   (c) True iteration (c) Definite or True iteration

6. How many entry and exit point in fundamental control structures?
   (a) Only one (b) One and two
   (c) Two and three (d) Only one and four

7. Which one of the following represent the solution method?
   (a) Flowchart (b) Pseudocode
   (c) Pseudocode or walkthrough (d) flow charts

8. A method of checking the Way in Which a computer will work using pseudocode or flow chart is called……………..
   (a) Algorithm (b) Walkthrough (c) Iteration (d) Sequencing

9. Which method give more importance to the procedures and not for the data?
   (a) Top-down approach (b) Object oriented approach
   (c) Walkthrough (d) Structured programming

10. Which method give importance to both procedure and data?
    (a) Object-oriented approach (b) Top-down approach
    (c) Structured programming (d) Solution method

11. Who developed C programming language?
12. Which one of the following is a source program text that the compiler does not break down into elements?
   (a) Constant       (b) Identifier       (c) Token       (d) Operator

13. In the statement "N = N + 1; ; denotes ............
   (a) constant       (b) Variable       (c) Identifier       (d) Variable

14. Which one of the following is of numeric or non-numeric type?
   (a) Constant       (b) Variable       (c) Identifier       (d) Keyboard

15. A non-numeric data can be called a ............
   (a) immutable       (b) literal       (c) numeric data       (d) integer data

16. How many numeric constants in C?
   (a) Two       (b) Four       (c) Six       (d) Three

17. An integer constant is a base ............
   (a) 2       (b) 8       (c) 10       (d) 16

18. The hexadecimal constant begins with.
   (a) Ox or Ox       (b) O or Ox       (c) OX or ox       (d) Ox

19. Which one of the following is a octal constant?
   (a) 074       (b) OX74       (c) 74       (d) 174

20. Which letter is used to represent the floating point constant in exponent form?
   (a) F or f       (b) E or e       (c) E or F       (d) e or f

21. A character is a ............
   (a) Letter       (b) number or special symbol
   (c) letter or special symbol       (d) letter, number or special symbol

22. Which one of the following is a invalid character constant?
   (a) ‘+’       (b) “”       (c) ””       (d) ‘A’

23. A string constant enclosed within ............
   (a) single quotes (’’)       (b) Double quotes (“ “)
24. By default, the last character in a" string constant is ………….. 
   (a) /0  (b) \1  (c) \0  (d) \1
25. The physical length of the string “school” is ………….. 
   (a) 5  (b) 6  (c) 8  (d) 7
26. Identifiers are the name given to the ………….. 
   (a) variables  (b) keywords  (c) punctuation  (d) constants
27. The maximum length of the variable name in C is ………….. 
   (a) 256  (b) 255  (c) 32  (d) 16
28. Which one of the following is not a valid variable name? 
   (a) a123  (b) x  (c) x-value  (d) for
29. Which one of the following cannot be used as identifiers? 
   (a) Numbers  (b) characters  (c) special symbol  (d) keywords
30. Which one of the following is most commonly used terms in programming? 
   (a) Identifiers  (b) Variables  (c) Data  (d) constant
31. How many fundamental data types in C? 
   (a) Two  (b) Three  (c) Four  (d) Many
32. How many bytes of memory requires to store Integer value? 
   (a) 2  (b) 4  (c) 5  (d) 8
33. A character requires ……. to store it in a memory. 
   (a) 2 bytes  (b) 1 byte  (c) 0 byte  (d) 4 bytes
34. Which one of the following is a derived data type in C? 
   (a) int  (b) char  (c) unsigned  (d) oat
35. The variables of C classified into ………….. 
   (a) ordinary variables and shell variables  (b) pointer variables and ordinary variables 
   (c) Pointer variables and shell variables  (d) shell and scrip variables
36. How many operators are associated with pointers? 
   (a) Two  (b) Four  (c) Eight  (d) Six
37. The symbol used to denote address of operator is …………..
38. Which symbol is used to denote indirection operator?
   (a) !  (b) *  (c) @  (d) $

39. Which operator is used to obtain the address of the variable?
   (a) &  (b) @  (c) $  (d) #

40. The direction in which operations are carried out is called.
   (a) hierarchy  (b) operators  (c) statements  (d) associativity

41. How many types of operators in C?
   (a) Two  (b) Three  (c) Four  (d) Many

42. Which operator have only one operand?
   (a) Unary  (b) Binary  (c) Ternary  (d) Unary and Binary

43. Which one of the following is an increment unary operator?
   (a) +  (b) ++  (c) &  (d) –

44. Which one of the following operators return true, if both the operands evaluate to true?
   (a) &&  (b) | |  (c) !=  (d) <=

45. The most frequently used assignment operator is ………….
   (a) =  (b) !=  (c) +=  (d) *=

46. Consider the expression j = I < 0 ? i= i – I if i=5, what will be the value of j?
   (a) 0  (b) 5  (c) 4  (d) 6

47. The punctuation symbol used to represent a comment in C is …………….
   (a) /**/  (b) !--and--  (c) */*  (d) *//*

48. All the statements in C end with ………….
   (a) .  (b) ;  (c) :  (d) { } 

49. Which one of the following is defined as a set of Instructions?
   (a) Statements  (b) Variables  (c) Program  (d) Operators

50. C programs are made up of ………….
    (a) Identifiers  (b) Function
    (c) Variables  (d) Punctuation symbols
51. How many types of statements in C program?
   (a) 3  (b) 2  (c) 6  (d) 4

52. `#include <stdio.h>` is called …………..
   (a) preprocessor statement  (b) function header statement
   (c) declaration statement  (d) executable statement?

53. In the statement `n = printf(“School”)` where `n` is an integer, what is the value of `n`?
   (a) 5  (b) 6  (c) 7  (d) 4

54. The statement `i = i + 1` can be written as …………..
   (a) ++I  (b) i++  (c) i += 1  (d) i+i, i++ or i += 1

55. The statement `a = b > c` is an example of …………..
   (a) arithmetic expression  (b) relational expression
   (c) assignment expression  (d) logical expression

56. If `x = 100`, `z = (x = x++)`, then the value of `z` is …………..
   (a) 0  (b) 1  (c) 100  (d) 101

57. How many types of character take by the control string of `printf( )` function?
   (a) Two  (b) Three  (c) Four  (d) Many

58. Which one of the following formatting character is used to displays the value as an integer?
   (a) %d  (b) %f  (c) %i  (d) %Id

59. If `y = 10.5`, the output of `printf(“%f”,y);` is …………..
   (a) 10.5  (b) 10.50  (c) 10.500000  (d) 10.500

60. Which of the following operator provide the address of the variable?
   (a) $  (b) #  (c) &  (d) @

61. The function which calls another function, the other function is termed as………..
   (a) calling function  (b) function prototype
   (c) function model  (d) called function

62. Defining a function within …………..
   (a) { }  (b) [ ]  (c) < >  (d) ( )

63. A stack is a ………….. structure.
64. LIFO stands for …………….
   (a) Local-In-Function-Out  (b) Last-In-First-Out  
   (c) Last-In-Function-Out  (d) Local-In-First-Out

65. Which of the following are the attributes of a variable?
   (a) Name and type  
   (b) Name and value  
   (c) Value and type  
   (d) Name, type and value

66. How many types of storage classes provided by C?
   (a) 3  
   (b) 4  
   (c) 6  
   (d) 2

67. Which one of the following in not a storage class?
   (a) Auto  
   (b) Static  
   (c) Type  
   (d) Extern

68. Which one of the following variable values are retained even after execution of the function?
   (a) Auto variable  
   (b) Static variable  
   (c) Local Variable  
   (d) Register variable

69. The variables are accessed by the function in a file other than one in which they are declared is …
   (a) static  
   (b) auto  
   (c) register  
   (d) extern

70. Which one of the following statement controls conditional branching?
   (a) for  
   (b) auto  
   (c) register  
   (d) extern

71. Which one of the following call as a nested-if structure?
   (a) if  
   (b) if-else  
   (c) if-else-if  
   (d) for

72. Which one of the following statement is the modular replacement of nested-if-else structure?
   (a) switch-case  
   (b) for  
   (c) while  
   (d) if-else

73. Which one of the following statement transfers the control out of the switch-case statement?
   (a) switch  
   (b) break  
   (c) default  
   (d) case

74. Which one of the following statement is executed if no case is equal to the value of switch?
   (a) switch  
   (b) default  
   (c) break  
   (d) case

75. How many control statements in C?
   (a) Three  
   (b) Two  
   (c) Four  
   (d) Six

76. Which one of the following is not a control statements?
77. Which one of the following loop is a definite repetition loop?
(a) while  (b) do-while  (c) while or do-while  (d) for

78. Which one of the following loop the condition is checked at exit level?
(a) for  (b) while  (c) do-while  (d) for and while

79. The number of elements of an array must be ...........
(a) < 0  (b) > 0  (c) < 1  (d) > 1

80. How many types of arrays in C?
(a) 3  (b) 2  (c) 4  (d) 5

81. An array’s index starts from ............
(a) 0 to n  (b) 1 to n  (c) 1 to n-1  (d) 0 to n-1

82. Which of the following provide the same value in an array?
(a) a[0], *a  (b) & a[0], *a, *a[0]
(b) *(& a[0]), a[0]  (d) a[0], *a, *a(&a[0])

83. Which symbol represents “all are one and the same“?
(a) <= >  (b) = =  (c) =  (d) [ == ]

84. The function used to find the length if the string is ............
(a) string length ( )  (b) len ( )  (c) length ( )  (d) strlen ( )

85. In multi-dimensional array the first dimension represents the numbers of ............
(a) rows  (b) columns  (c) pointers  (d) variables

86. How many index variables (indicates) required for multi-dimensional array?
(a) 3  (b) 2  (c) 4  (d) many

87. Which one of the following are derived data types in C language?
(a) structures  (b) int  (c) float  (d) double

88. Which one of the following are used to define records to be stored in files in C?
(a) Arrays  (b) programs  (c) Structures  (d) Folders

89. A record is a collection of ............
(a) files  (b) fields  (c) folders  (d) datas
90. Which one of the following is a collection of fields?
   (a) Files  (b) Folders  (c) Pointers (d) functions

91. Which is a heterogeneous collection of elements?
   (a) Arrays  (b) Pointers  (c) Structures (d) Struct tag

92. The structure identifier is called …………..
   (a) structure name  (b) structure tag or structure name
   (c) tag name  (d) structure tag or tag name

93. Which one of the following is member of a structure?
   (a) Fields  (b) Files  (c) Records (d) Data types.

CHAPTER 11

1. HTML Stands for …………………
   (a) Hyper Text Makeup language  (b) hyper Text Markup language
   (c) High Text Markup Language  (d) Hyper Text memory text

2. Which of the following is network of network?
   (a) Networks  (b) Files  (c) WWW  (d) Folders

3. The birth date of hyper text documents is …………………
   (a) June 12, 1989  (b) June 12, 1991  (c) june 12, 1990 (d) june 12, 1992

4. Which of the following called as web page are files stored on computers?
   (a) Web Sites  (b) Web Servers  (c) Web Clients (d) Web Browser

5. Which of the following used by web clients to view the web pages?
   (a) Web Clients  (b) Web browser  (c) Web Servers  (d) Web Sites

6. Web pages are created by using …………………
   (a) HTML  (b) HTTP  (c) Web Clients (d) Web servers

7. Which of the following used by the internet to transfer hypertext documents?
   (a) HTML  (b) Web Browser  (c) Web Servers  (d) HTTP

8. URL Stands for ……………
   (a) Universal Resource Locator  (b) Universal Reform Locator
   (c) Uniform Resource Locator  (d) Union Redource Locator
9. HTTP stands for ...............  
   (a) Hypertext Transfer Protocol  
   (b) Hyper Text Transmission Protocol  
   (c) Hyper Text Transfer Transmission Protocol  
   (d) Hyper Text transfer Procedure

10. Which of the following standards are defined by WWW consortium?  
   (a) HTTP and web pages  
   (b) HTML and web  
   (C) HTML and HTTP  
   (d) Web clients and webservers

11. The Hypertext Markup language is composed of ...............  
   (a) HTTP  
   (b) Tags  
   (c) Instruction  
   (d) Comments

12. Which of the following is used to create web pages?  
   (a) HTML and HTTP  
   (b) HTML and Notepad  
   (c) Notepad or Front page  
   (d) HTML, Notepad or Front page

13. A web document starts and ends with ...............  
   (a) <Head> … </Html>  
   (b) <Body> … </Body>  
   (c) <Html>… </Html>  
   (d) <Title> …</Title>

14. Which of the following is always used to enclosed HTML tags?  
   (a) { }  
   (b) < >  
   (c) >  
   (d) [ ]

15. The HTML elements starts and ends with ...............  
   (a) <Html> … </Html>  
   (b) <Html> … </Html>  
   (c) <Head> … </Head>  
   (d) <Html> … </Html>

16. How many parts are there in a web document?  
   (a) Four  
   (b) Three  
   (c) Two  
   (d) Six

17. The comment can be included using ...............  
   (a) < >  
   (b) <! -- and -->  
   (c) <!--and -->!>  
   (d) <!-- and -->

18. Which of the following tag is optional?  
   (a) <HTML>  
   (b) <Body>  
   (c) <HEAD>  
   (d) </HTML>

19. Which of the following tag is used to provide a name to a web document?  
   (a) <Head>  
   (b) <HTML>  
   (c) <TITLE>  
   (d) <Body>

20. Which of the following tag is not visible in the browser?
21. In which section meta tags are placed?
   (a) Title section  (b) Head section  (c) Body section  (d) Head or Body section

22. What are the attributes used with meta tag?
   (a) Name and centre  (b) Content and http-equiv  (c) Name, content, http-equiv  (d) Name and http-equiv

23. Which tag can be used for automatic reloading of pages at specific intervals?
   (a) <Head>  (b) <HTML>  (c) <Body>  (d) <Meta>

24. Which attribute is used to identify the URL and number of seconds in meta tag?
   (a) Name  (b) Content  (c) http-equiv  (d) Seconds

25. Which of the following is used to separate the waiting time and the URL using content attribute of meta tag?
   (a) :  (b) ,  (c) ;  (d) !

26. Which of the following tags are used within the heading section?
   (a) <Title>  (b) <Meta>  (c) <Style>  (d) All of these

27. Which tag is used to change the default characteristics of a tag in the entire web document?
   (a) <style>  (b) <meta>  (c) <Head>  (d) <Title>

28. How many segments a style tag has?
   (a) Three  (b) Two  (c) Four  (d) Six

29. Which of the following are the segments of a style tag?
   (a) Name and content  (b) Selectors and property  (c) Name and property  (d) Property and content

30. Which of the following section of a web document can contain many HTML tags?
   (a) Head section  (b) Title section  (c) Style section  (d) Body section

31. Which of the following enhancing the usage of tags?
   (a) Comments  (b) Attributes  (c) Functions  (d) Options

32. Which of the following changes the background color to white?
33. The color range obtained by using ............
   (a) White, black, grey  (b) Red, green, black
   (c) Red, white, black  (d) Red, green, blue

34. The hexadecimal number with the color black is ...........
   (a) #FF00FF  (b) #FFFFFF  (c) #000000  (d) #00FFFF

35. In decimal, the color values range from ..............
   (a) 0 to 16  (b) 0 to 256  (c) 0 to 255  (d) 0 to 257

36. Which of the following tags are used to change the background color of the web page?
   (a) Body tag and style tag  (b) Style tag and Head tag
   (c) Style tag and HTML tag  (d) Body tag and HTML tag

37. The commonly supported Images by browsers are ............
   (a) .gif  (b) .jpg  (c) .gif or .jpg  (d) .bmp or .gif

38. The default text color is ...........
   (a) red  (b) white  (c) blue  (d) black

39. Which of the following heading tag have a very big font size?
   (a) <h1>  (b) <h2>  (c) <h6>  (d) <h3>

40. Which of the following heading tag have a very small font size?
   (a) <h2>  (b) <h1>  (c) <h6>  (d) <h3>

41. The attribute used to centre the heading in a web page is ............
   (a) centre  (b) align  (c) <hc>  (d) heading centre

42. By default, in the web page the paragraphs are aligned to the ...........
   (a) right  (b) centre  (c) left  (d) top

43. Which attribute of the <p> tag to align the paragraph?
   (a) Style  (b) Align  (c) Right  (d) Left

44. Which of the following tag is used to insert a line break?
   (a) <break>  (b) <line break>  (c) <br>  (d) <brk>

45. Which of the following is not having a closing tag?

53
46. The default type of an HTML document is ………… .
   (a) Arial               (b) Time New Roman
   (c) Ms scansherif       (d) Arial black

47. Which of the following tag is used to insert a graphics ?
   (a) <Image>              (b) <Img>
   (c) <Bgpicture>         (d) <Picture>

48. By default, the text messages used in <Img> tag are aligned at……… .
   (a) bottom              (b) centre
   (c) left                (d) top

49. Which of following tag is used to create a hyper link to another document ?
   (a) <img>               (b) <link>
   (c) <a>                (d) <anchor>

50. Which symbol stells the browser to look for the link within the same document ?
   (a) @                   (b) !
   (c) #                   (d) $

51. The audio file should be specified using the attribute ………… .
   (a) src                 (b) href
   (c) src or href         (d) loop

52. Which of the following audio format files accepted in HTML ?
   (a) .mid or .au        (b) .au or .war
   (c) .war or .mid       (d) .mid, .au and .war

53. Which value of the loop attribute directs the browser to play the sound indefinetly ?
   (a) End                 (b) Infinite
   (c) Indefinite          (d) Infinity

54. The attribute used to play a movie in the browser using <IMG> tag is …….. .
   (a) src                (b) href
   (c) dynsrc or src      (d) dynsrc or src

55. How many kinds of lists in HTML ?
   (a) Three               (b) Two
   (c) Four                (d) Six

56. The unordered list starts with a list ……………
   (a) <ol>… <ol>        (b) <ul> … <ul>
   (c) <dl> … <dl>       (d) <li> … <li>

57. A definition list starts with ………… .
   (a) <dl>              (b) <dt>
   (c) <dd>            (d) <ul>
58. Which of the following creates a list with bullets?

(a) <dl>  
(b) <dd>  
(c) <ul>  
(d) <ol>

59. Which of the following is used to create a table on a web document?

(a) <Tr>  
(b) <Table>  
(c) <Th>  
(d) <TD>

60. Which of the following tag is used to represent column heading?

(a) <TH>  
(b) <Table>  
(c) <Tr>  
(d) <TD>

61. Which of the following tag is used to represent an entry in a table?

(a) <TH>  
(b) <Tr>  
(c) <Tr>  
(d) <Table>

62. Which property of the table tag is used to create a border in the table?

(a) br  
(b) bd  
(c) border  
(d) Tborder

63. Which of the following attribute indicates the numbers of columns to span in a row?

(a) spanc  
(b) spancols  
(c) colspan  
(d) cols

64. Which attribute refers to the space between cells?

(a) space  
(b) cellspacing  
(c) cell padding  
(d) spanspace

65. The spaces between cells in a table should be in ............

(a) points  
(b) numbers  
(c) pixels  
(d) inches

66. Which of the following are used to receive information from the user?

(a) Forms  
(b) Frames  
(c) Tables  
(d) Menus

67. Which of the following is used to enter values into the form?

(a) Check boxes  
(b) Radio buttons  
(c) Drop-down list  
(d) Text boxes

68. Which attribute will send the names and values of the form elements as packets?

(a) Action  
(b) Post  
(c) Method  
(d) Get

69. CGI stands for ..............

(a) Common Gateway Information  
(b) control Gateway Interface  
(c) Common Gateway Interface  
(d) Control Gateway Information

70. Which of the following tag is used to create a form element?

55
71. Which attribute is used to name the input element in a form?
   (a) name  (b) text  (c) Password  (d) file

72. Frames are created using …………….
   (a) <frames>  (b) <set>  (c) <frameset>  (d) <colsrows>

73. A web page with frames should not have …………….
   (a) head section  (b) body section  (c) title section  (d) meta section

74. Which of the following attribute makes the frame fixed?
   (a) frame  (b) size  (c) resize  (d) noresize

75. Which of the following is the web authoring program for MS-Windows?
   (a) MS-Front page  (b) Java scripts  (c) ASP  (d) Perl

76. Which of the following is the most widely used web authoring applications?
   (a) HTML  (b) Java scripts  (c) MS-Front page  (d) Perl

77. Which of the following view identifies problems with pages and links in the web?
   (a) Hyperlinks view  (b) Task view  (c) Page view  (d) Reports view

78. To open a web which is already created by …………….
   (a) File → Open  (b) File → Web Open  (c) File → Open Web  (d) File → Web

79. To create a web …………….
   (a) File → New  (b) File → Web → New
   (c) File → New → Web  (d) File → Web → New

BEST WISHES
FROM
P.CHANDRASEKrán